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Proposed R.O.W. & Easements on T.D.O.T. Projects 

Introduction 

This document shows how proposed R.O.W. and easements are to be stored using Geopak & 
MicroStation.  Step by step instructions are provided to show how to define, store and display them.  
Proposed R.O.W. and easement information must be stored in the project’s GPK coordinate geometry 
database in order to facilitate its use by the T.D.O.T. R.O.W. division.  

Proposed R.O.W. 

All proposed R.O.W. is to be stored in the project's GPK COGO database using the feature PROW. 
This includes all R.O.W. break points and property line intersections. These points and curves are 
combined in chains for any continuous stretch of proposed R.O.W. All areas to be acquired are stored 
as special parcels named with their associated parcel/tract number and the “acquired” designation 
(acquired area for parcel/tract 5: Parcel 5ACQ).  

As stipulated by T.D.O.T. Department Policy: 

1. Proposed R.O.W. Lines should be based on slope line limits offset at the appropriate proposed 
R.O.W. offset distance except in cases where only minimum R.O.W. is to be acquired. 

2. Proposed R.O.W. break points (a point at which there is a change in direction) should be located at 
the extreme points of slope line limits in order to maintain the appropriate proposed R.O.W. offset 
distance. For minimum R.O.W. these break points will correspond to roadway centerline 
alignment key points. 

3. Proposed R.O.W. break points should not be located at property lines. The only accepted 
exceptions to this rule are cases where the entire parcel/tract is to be acquired and the proposed 
R.O.W.  follows the existing property lines or where the end of the proposed R.O.W. ties to an 
existing R.O.W. break that is also a property corner. 

4. Proposed R.O.W. and property line intersections will be located in order to close areas to be 
acquired on individual parcels/tracts. 

Proposed Easements 

Easements are to be stored in the project's GPK COGO database using the appropriate feature; 
DEASMT (drainage), CEASMT (construction) & SEASMT (slope). Drainage easements and 
construction easements (other than those for slope construction) are stored & annotated like proposed 
R.O.W. is done. Slope easements and their associated construction easement areas are stored directly 
from graphics only. All easement areas are stored as special parcels named with their associated 
parcel/tract number and the easement type designation (slope easement for parcel/tract 5: Parcel 
5SLP). 
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 Proposed R.O.W.  

Set Tentative Proposed R.O.W.  

If the proposed R.O.W. is to be based on the slope line limits take the steps listed below.  

On projects where only minimum proposed R.O.W. is to be used you can use MicroStation's Copy 
Parallel by Distance command to copy the centerline at the appropriate offset distance. Then skip on 
to the section describing the process of storing proposed R.O.W. points.  

1. Locate the limits of proposed R.O.W. needs.  

Open the proposed DGN file for your project.  In MicroStation’s Level Display tool, set level 
DESIGN - ROW - ROW and Easement GPK Visualizations as the active level and use level 
filter Design - ROW Work to set the levels to be displayed for all files. 

Using MicroStation's Copy Parallel by Distance command copy the high points of slope lines 
parallel at the specified R.O.W. offset. This distance varies from project to project; see the 
roadway design standard drawing which your roadway is based on (RD- or RD01- drawing 
series). 
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2.  Draw in a tentative proposed R.O.W. line.   

Using MicroStation's Smart Line command create a line string through the locations located in 
step 1.  Settings for Smart line should be Lines, Sharp and Join Elements.   

If needed use MicroStation's Insert Vertex command to add additional breaks in order to 
maintain the specified R.O.W. offset. Do not set any break point at a property line. 
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Store Proposed R.O.W. Break Points 

1. Open your Geopak project and start Coordinate Geometry. 

2. Set the active COGO feature to PROW.  

In the COGO dialog click on the Browse button. In the SMD browser window select PROW 
under Design > Property/ROW. 

 

Change the visualization option in the COGO dialog to Permanent Visualization. 
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3.  Start Geopak Graphical COGO.  

Go to the MicroStation menu bar under  
Applications > Geopak Road > Geometry > Graphical Coordinate Geometry or choose the 
second icon on the Horizontal & Vertical Geometry toolbox  

 

4. Start Store Point.  

In the COGO toolbox, click on the upper left icon. Controls will then come up in the 
MicroStation tool settings dialog. 

Key in the initial point Id for your R.O.W. break points. All points should begin with a DR to 
indicate that they are Design R.O.W. points.  

Set Coordinates to Curvilinear for storing by station and offset.  

Click the down arrow to set the Chain Id name to the one the R.O.W. break points need to be 
stored from. 
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5. Locate 1st proposed R.O.W. break point.  

As you move the cursor across the view window the point can be seen tracking along the 
alignment chain. If tracking does not occur check to make sure the correct chain name is set and 
click on the store point icon again.  

Zoom in on the location for the first point and snap to the beginning of the tentative R.O.W. line. 
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6.  Store 1st proposed R.O.W. break point.  

Click the box next to Station and the one next to Offset to lock them.  

Adjust station and offset as needed. After adjusting a value hit the Tab or Enter key to set the 
value. All offset values to the left of the centerline should be negative numbers. In our example, 
this tie is to an existing R.O.W. break so these do not need to be changed to even values.  

Once station and offset are set, data point anywhere in the view to store the point. In graphics the 
point symbol and number are visualized on level DESIGN - ROW - ROW and Easement GPK 
Visualizations (273).  

 

The COGO window reflects the action showing the point being stored by station and offset.  

 



 8

7. Locate & Store 2nd proposed R.O.W. break point.  

The point Id automatically goes to the next available number when the 1st point is stored. Un-click 
the boxes next to Station and Offset to return to tracking mode.  

Tentative snap to the first break along the tentative R.O.W. line.  Lock station and offset and then 
adjust station and offset as needed to place at even station and offset values.  After adjusting a 
value hit the Tab or Enter key to set the value. 

Once station and offset are set, data point anywhere in the view to store the point. In graphics the 
point symbol and number are visualized.  

                        
          Initial tentative location     Final stored location 
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8. Locate & Store remaining proposed R.O.W. break points.  

Using step 7 as needed store the remaining proposed R.O.W. break points in one continuous run 
of proposed R.O.W.  

At this point you may wish to go on to the next section which shows how to store a proposed 
R.O.W. chain or you may wish to store all points prior to building any chains.   

 

9. (As Needed) Store curve for proposed R.O.W.  Depending on the length of curve needed 
different methods are used. If the name of the roadway centerline curve or radius is not known use 
COGO navigator to review the centerline chain to find this information. 

For concentric curves with same coverage as roadway curve … 
 In the COGO dialog go to the drop down menu item Element > Curve > Store > Concentric. 
Enter a new curve name, the desired offset value (negative values for left side) and highlight the 
centerline curve in the list. Hit Store Curve and the new curve is stored. 

For concentric curves shorter than roadway curve … 
Store COGO points at the PC & PT locations. In the COGO dialog go to the drop down menu 
item Element > Curve > Store > By End Points. Enter a new curve name, double click on PC & 
PT points to fill in dialog values and set a control value. For R.O.W. the control values of either 
Radius or a previously located POC point are normally used. Set the direction of the curve, 
Clockwise or Counterclockwise, so that the curve goes in the direction of the roadway centerline. 
Hit Store Curve and the new curve is stored. 
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Store Initial Proposed R.O.W.  Chain 

This section describes storing the initial proposed R.O.W. chain using break points only. In the next 
section this chain is used to calculate intersection points at locations where the R.O.W. line crosses 
existing property lines. The final proposed R.O.W. chain can then be stored with the break points and 
the intersection points maintaining all bearings. 

For our example we only use points in our chains, these could also include curves if needed. Simply 
double click on the visualized curves to include them in the element list. 

1. Start the Store Chain command.  

Click on the store chain icon on the main COGO dialog or go to the drop down menu item 
Element > Chain > Store > From Elements. 
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2.  Fill in Store Chain dialog & store chain.  

Enter the desired R.O.W. chain name. It should begin with a D for Design chains and we 
recommend the use of ROW so that it is easily recognized as a proposed R.O.W. chain.  

Station values do not matter so just use the setting, Begin at 0.00.  

Click once in the Elements List area. Double click on each of the visualized break points 
previously stored. It is not necessary to snap to the exact locations, in fact you can double click 
on the point name text which makes it easy to add these.  

Finally click on the Store Chain button to store the chain. 

 

The chain is automatically visualized on level DESIGN - ROW - ROW and Easement GPK 
Visualizations (273).  In the COGO dialog, we can see the chain has been stored. 
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Store Proposed R.O.W. & Property Line Intersection Points 

1. Set the level display to show only proposed R.O.W. and Parcels.  

If not already set in the proposed DGN file, use MicroStation’s Level Display tool to set level 
DESIGN - ROW - ROW and Easement GPK Visualizations as the active level and use level 
filter Design - ROW Work to set the levels to be displayed for all files. 

Parcels should be visualized in the Survey topo reference file on level SURVEY - PROPERTY - 
Parcels (26). If parcels are not visualized in the survey file, use Geopak’s COGO Navigator to 
visualize any needed parcels. Visualize Element is the paint brush icon on the navigator. 

 

2. Start Geopak Graphical COGO.  

Go to the MicroStation menu bar under  
Applications > Geopak Road > Geometry > Graphical Coordinate Geometry or choose the 
second icon on the Horizontal & Vertical Geometry toolbox  

3. Start Intersect Elements.  

On the COGO toolbox pull out the Modify Elements tool strip on the upper right. Click on the 
Intersect Elements icon. 
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4. Store 1st Intersection Point.  

Controls will come up in the tool settings dialog.  

Key in the next available point Id, usually this will fill in automatically if you have been storing 
points.   

Data point to identify the proposed R.O.W. line and data point again to accept it.  

When you are prompted for the second element, data point on the property line/parcel line which 
the R.O.W. intersects.    Data point again to accept it.  

A circle will appear at the intersection. Data point to accept the location. If more than one 
intersection solution exists then you may need to reset to go to the correct one. 

 

After accepting the desired intersection point, the point is stored and visualized. 

 

5. Store remaining Intersection Points.  

Repeat step 4 to store any other points where the proposed R.O.W. crosses existing property lines. 
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Store Final Proposed R.O.W.  Chain 

1. Open COGO Navigator and access the Proposed R.O.W. Chain.  

Since we are re-defining this chain, click on the Re-Define button on the COGO dialog.  

Open COGO Navigator and double click on the proposed R.O.W. chain. The Store Chain by 
Elements dialog will open with the current definition of the chain displayed. 

 

If the Store Chain by Elements dialog does not open, in COGO Navigator go to the drop down 
option Tools > Settings, and in the Settings dialog set the Double Click option to Edit Element. 
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2. Add intersection points & re-store chain.  

In the Store Chain by Elements dialog click in the Elements list area at the location where an 
intersection point needs to be added.  

In our example we need to add point DR509 between DR501 & DR502.  Add a space after 
DR501 and then double click on visualized DR509 which adds it to the list.  

Repeat that action to put in other intersection points. For this example we are also adding point 
DR510 between DR503 & DR504. Once done, click on the Store Chain button to re-store the 
chain. 

 

In the COGO dialog, we can see the chain has been redefined. 
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Display & Annotate Proposed R.O.W. 

Proposed R.O.W. can be annotated using batch methods accessed through Design & Computation 
Manager which will place multiple labels at a time. We will discuss these batch methods first and 
then go on to some other labeling tools that place one label at a time. 

1. Open the proposed DGN file for your project if you do not have it open already.  Delete any 
tentative prop. R.O.W.  line strings and slope lines copied parallel for prop. R.O.W. development. 
Do not delete any visualized prop. R.O.W. COGO graphics since these are required for storing 
parcel areas to be acquired. 

2. In MicroStation’s Level Display tool, set level DESIGN - ROW - Right-of-Way Linework as 
the active level and use level filter Sheets - ROW Details to set the levels to be displayed for all 
files. If your plans do not include R.O.W. Details sheets then use level filter Sheets - Present 
Layout. 

3. Open Geopak’s Design & Computation Manager and access Proposed R.O.W.   

Select the type of R.O.W. line needed and then click on Draw Plan & Profile. 
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4. Draw prop. R.O.W. line work and annotate bearings & distances on lines and length & radius on 
arcs.  

 In the Draw Plan & Profile dialog set element option to Chains  

Set the Label Scale to 50.   

All other controls are pre-set. Click on the proposed R.O.W. chain once.  

Line work & annotation is placed. 

 



 18

5.  Place proposed R.O.W. station/offset flags and markers.  

This program is set up to work on lines displayed for proposed R.O.W. using D&C 
Manager. Use of line strings or complex chains produced by other methods will not produce 
the desired results. 

 Temporarily, turn off all levels except level DESIGN - ROW - Right-of-Way Linework (45). 
Highlight all files in MicroStation’s Level Display tool, right click on your mouse in the level list 
and choose the option All Off. 

Using MicroStation's Selection Set tool, upper left icon on MicroStation's main tool box, make a 
selection set of all proposed R.O.W. lines that are in a continuous run and are to be referenced to a 
particular centerline chain.  

Data point & hold the mouse button down to drag a box across the elements to get the prop. 
R.O.W. elements in the selection set. Hold the Ctrl key down and data point any additional 
elements to add them.  

In D&C Manager under Prop. R.O.W., double click on the item ROW Flags.  

 

First you are prompted for the project's job number. Key this in and click OK. 

 
Note:  
If no selection set has been created the 3PC program will generate an error message indicating this 
and will stop processing. 



 19

Then you are prompted for the chain name for flags to station off of. Key this in and click OK. 

 
Finally you are given an option to place prop. R.O.W. markers. Click OK to place them or Cancel 
to skip placement.  

 
Note:  
The type of marker needed (A, B or C) is figured based on the 45 degree rule: Any turn out from 
the centerline greater than 45 degrees requires a type C marker, any turn in towards the centerline 
greater than 45 degrees requires a type B marker and all others with turns less than 45 degrees 
require a type A marker. If no change in direction occurs at a break in the R.O.W. line then no 
marker is placed. 

6. Use level filter Sheets - ROW Details (or Sheets - Present Layout) to reset levels displayed for 
all files with MicroStation’s  Level Display tool 

Station/Offset flags are placed at all locations along the prop. R.O.W. lines in the selection set. 
Prop. R.O.W. markers and their text labels are placed everywhere except at the beginning and end 
or at any location where there is no change in direction. 

 



 20

7. Station/Offset Flag annotation clean up.  

To aide in the cleanup of flag locations the text information and its horizontal line form a single 
graphic group allowing them to be easily relocated with a single move command. The leader can 
then be modified to the new location of the horizontal line.  

Turn on Graphic Group lock. 

Using MicroStation's Move Element command, identify any flag text which overlaps other labels 
and reposition so that labels are clear and readable. In our example, we have moved out the first 4 
station and offset labels. 

 
The station & offset labels are placed by default at the angle of the centerline. If this is not the 
same as the angle of the sheet on which they appear, the T.D.O.T Design Division tool Rotate 
Element to Horizontal can be used to rotate them to match the sheet angle. It can be found under 
Tools in Geopak’s D&C Manager or under the TDOT drop down menu.  First, rotate the view to 
match the sheet angle. Then start Rotate Element to Horizontal, identify any element in the label, 
data point to accept and the graphic group is rotated to be horizontal to the view.  
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Using MicroStation's Modify Element command, grab the end of the leader line and tie it back to 
the end of the horizontal line with the flag text.  

 

8. Proposed R.O.W. Marker annotation clean up.  

A ROW marker and its text label form a single graphic group to aide in clean-up if the marker is 
to be removed totally.  

Turn off Graphic Group lock. 

Using MicroStation's Move Element command, identify any marker text which overlaps other 
labels and reposition so that labels are clear and readable. 
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 Annotating Single Segments of Proposed R.O.W. 

Proposed R.O.W. can be annotated one label at a time. In this section we will use other labeling tools 
for some clean up of the annotation placed by the batch methods. 

Some proposed R.O.W. lines which are short may end up with overlapping labels or when near the 
existing R.O.W. their labels may overlap. In our example this occurs near the beginning. To fix this 
problem we will replace those labels with ones with leader lines. 

T.D.O.T. Design Division Labeling Tools 

1. Start T.D.O.T. Design Division’s Place Bearing & Distance Label tool. 

In D&C manager activate BearingDistance. The Place Bearing & Distance Label dialog 
appears. When started, program immediately prompts user to Identify Element for annotation. 

 
With the T.D.O.T. Design Division interface active, this tool can also be accessed from the 
MicroStation drop down menu at TDOT > R.O.W. > Label Bearing & Distance 

2. Before placing labels, we need to set the appropriate active element settings.  

Click on the Text Styles Plus… button. Scroll through the list and pick ROW Bearing & 
Distance – Prop. 
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3. Start label placement. In the Place Bearing & Distance Label dialog … 

Turn on the option to Place Label as Flag. 

Reset the Terminator Type if desired. This option defaults to the small arrowhead which works 
best in crowded areas of annotation. 

Click on the Identify Element button. You are prompted to Identify Element for annotation, data 
point on the prop. R.O.W. line element.  

After giving a point to accept the element selected, the dialog is populated with label information 
and the user is prompted to Identify location for End of Leader. 

Data point on or near the element being labeled and you are prompted to Position Label. 
Movement of the cursor allows dynamic control of the leader line to the label text.  

 

After the label location point is given, the user is again prompted for the end of the leader point 
allowing for additional placement if needed. A reset will stop label placement and restart the tool 
at the Identify Element prompt. 

4. Continue placing additional labels as needed. 
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5. Use MicroStation's Delete Element command to remove the overlapping distance and bearing 
labels which have been replaced.  

 

Other T.D.O.T. Design Division Labeling Tools 

The Place Arc Radius & Length Label tool works just like the previous tool and is used for 
labeling any curves which may be included in the prop. R.O.W. In Text Styles Plus… use the 
same item, ROW Bearing & Distance – Prop. , to set text element parameters.  

It can be accessed from Geopak’s D&C Manager at Drafting Standards > Prop. R.O.W. > 
RadiusLegth or with the T.D.O.T. Design Division interface from the MicroStation drop down 
menu TDOT > R.O.W. > Label Arc Radius & Length 
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The Label Station/Offset tool can be used to label single proposed R.O.W. breaks or intersections 
with property lines. In Text Styles Plus… use item, ROW Sta. & Offset – Prop. , to set text 
element parameters. 

It can be accessed from Geopak’s D&C Manager at Drafting Standards > Prop. R.O.W. > 
StationOffset or with the T.D.O.T. Design Division interface from the MicroStation drop down 
menu at TDOT > R.O.W. > Label Station & Offset.   

 

The Place Label with Leader Line tool can be used to place generic text labels such as “PROP. 
R.O.W.”. In Text Styles Plus… use item, ROW & Easements – Prop. , to set text element 
parameters.  

It can be accessed from Geopak’s D&C Manager at Drafting Standards > Tools > 
LabelwithLeader or with the T.D.O.T. Design Division interface from the MicroStation drop 
down menu TDOT > Tools > Place Label with Leader 

 

We will illustrate the use of these tools later in the document. For complete documentation on 
special programs developed by T.D.O.T.’s Design Division for use in MicroStation with Geopak, 
refer to standard documentation file TDOTDesignDivisionPrograms.pdf. 

http://www.tdot.state.tn.us/Chief_Engineer/assistant_engineer_design/design/v8/TDOTDesignDivisionPrograms.pdf�
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Geopak’s Plan View Labeler 

As an alternative to the special T.D.O.T. Design Division labeling tools, Geopak’s Plan View Labeler 
can also be used to place single proposed R.O.W. labels. In this section we will use it for cleanup of 
the annotation placed at the beginning of our example. 

1. Access the Plan View Labeler tool. 

Access the Plan View labeler from the first icon in Geopak's Plans Preparation toolbox or from 
MicroStation's menu bar Applications > Geopak Road > Plans Preparation > Plan View 
Labeling. 

 

The Labeler dialog will open. T.D.O.T. Design Division's plan view label style file, 
tdotdef_plan.lsf, should open by default. It is listed at the top. 
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2. Go to the drop down option Scale > Change Scale and set the scale to 50 if not set already. Click 
OK to set the scale. 

.  

3. Click on the styles tab to go set the active style. We need to replace distance and bearing 
annotation so double click to Labels > Design Labels > Prop. ROW > Bea/Dis Flag.  

 

Other label styles are available for labeling radius & length on curves as well as station & offset 
labels for prop. R.O.W. breaks or property line intersections 

4. Click on the drop down item Options > Label Tools. This opens the Plan View Label Control 
toolbox. We will use these to assist in placing our labels.  

 

5. Using MicroStation's Delete Element command remove the overlapping distance and bearing 
labels which are to be replaced. This will make it easier to identify the proposed R.O.W. lines. 
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6. Click on the Identify Element icon in the Plan View Label Control toolbox. It's near the middle 
to the right of the big plus icon (that one is used to label points such as when labeling a station & 
offset). You are then prompted to identify an element. Data point on the first R.O.W. line to be 
labeled. Reset if needed until the prop. R.O.W. line on level DESIGN - ROW - Right-of-Way 
Linework (45) is identified. Data point again to accept.  The label is now ready for placement but 
the angle must be set first. 

 

Note:  
Check the information displayed in the data window of the Labeler dialog. Sometimes the 
compass directions of bearings may be reversed (northwest instead of southeast).  If so click on 
the Identify Element icon again and grab the line at the other end of the line from where you first 
identified it. The bearing direction should be as needed this time. 

7. We want to set the angle of the label to our current active angle of 0. Click on the Rotate tab and 
then double click on the AA button. This should change the current angle to 0 also and the label 
should now be oriented correctly. 

The angle is sometimes the hardest thing to get set correctly. The labeler uses something 
called the current angle in conjunction with whatever method of angle placement you use. 
You should always "Zero out" this value prior to starting a series of labels. 
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Position the label and data point to place. After initial placement a circle will appear on the end of 
the horizontal line of the leader. Position this circle on the end you want the leader to go to and 
data point to finish the label and leader. Reset to end placement of this label. 

 

8. Repeat the previous actions as needed to place additional labels. The leader line always goes to the 
center of the element.  To correct this, you must drop the complex status of the label cell first.  
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Place Single Proposed R.O.W. Marker 

When modifications are done to proposed R.O.W. where it ties to existing R.O.W. or where it turns to 
go up a side road it may be necessary to place a single proposed R.O.W. marker. Take the following 
steps to accomplish this. 

1. Create a MicroStation selection set of the two R.O.W. lines. They should be selected in a 
forward direction along the main roadway. Hold Ctrl down on the keyboard and data point on 
the lines in order as shown below. 

On the first intersection of the side road’s R.O.W.  or on the other side 

  

Where existing & proposed R.O.W. tie together  
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2.  In D&C Manager under Prop. R.O.W., double click on the item ROW Marker. 

 
3. First you are prompted for the project's job number. Key this in and click OK. 

 
Note:  
If no selection set has been created the 3PC program will generate an error message indicating this 
and will stop processing  

4. Then you are prompted for the chain name for the marker annotation to be aligned with. Key this 
in and click OK.  

 
The type of marker needed is calculated based on the 45 degree rule and is then placed and 
annotated. 
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Count R.O.W. Markers 

For tabulating proposed R.O.W. marker quantities the following Geopak 3PC program has been 
developed and is accessed through D&C Manager. On each use it appends the data gathered to the 
CSV (comma separated values) file ROWMARKERS.CSV which can then be imported into an 
Excel tabulation block. 

1. Set the active level to DESIGN - ROW - Right-of-Way Markers (272) and turn off all other 
levels in the proposed DGN file so that only proposed R.O.W. markers are showing 

2. Create a selection set of all the elements in any sheet area.   

3. In D&C Manager under Pay Items, double click on the item ROW Markers. 

 
4. You are first prompted for the sheet number for the area you are tabulating. Key in the appropriate 

number and click OK. 

 

5. The markers are tabulated from the selection set and when finished the following completion 
message is displayed. 

 
6. Repeat steps 2 through 5 to tabulate all sheet areas. Review the file ROWMARKERS.CSV for 

results. Column A is the sheet number and the rest are the numbers of type A, B & C markers. 
This data can now be imported into the Excel prop. ROW marker tabulation block for the project. 
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Proposed Easements 

Easements are to be stored in the project's GPK COGO database using the appropriate feature; 
DEASMT (drainage), CEASMT (construction) & SEASMT (slope).  

Setting Up Drainage or Special Construction Easements  

Drainage easements and construction easements (other than those for slope construction) are stored & 
annotated like proposed R.O.W. is done. The only exception is the Geopak feature name which is 
used and the D&C Manager items used for linework displays.  

In the example below we will set up a drainage easement and briefly illustrate these methods 
discussed previously for proposed R.O.W. as used with easement definition. 

1. Set up tentative proposed drainage easement lines.  

Open the proposed DGN file for your project.  In MicroStation’s Level Display tool, set level 
DESIGN - ROW - ROW and Easement GPK Visualizations as the active level and use level 
filters Design - ROW Work & Sheets - Proposed Layout to set the levels to be displayed for all 
files. The proposed layout filter is included so that drainage structures which determine the limit of 
easement can be seen. 

Drainage Easements should be aligned with the structures they are based on so in our example we 
will first use MicroStation's Copy Parallel command to copy the pipe over the outside of the 
endwall and then switch to Move Parallel by Distance to get the limit of the easement to the left 
and right. On the outside, draw a line across the outside of endwall and then Move Parallel by 
Distance to get the outside tentative easement line set. If rip-rap is used with the structure, it 
should be considered part of the structure and the easement should be adjusted accordingly. 
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Finally, use MicroStation’s Extend Line to Intersection commands to clean up the 4 corners. 

 

2. Store proposed drainage easement points in COGO. 

Open your Geopak project and start Coordinate Geometry. 

Set the active COGO feature to DEASMT.  In the COGO dialog click on the Browse button and 
in the SMD browser window select DEASMT under Design > Property/ROW. 

Change the visualization option in the COGO dialog to Permanent Visualization. 

Start Geopak Graphical COGO. Go to the MicroStation menu bar under  
Applications > Geopak Road > Geometry > Graphical Coordinate Geometry or choose the 
second icon on the Horizontal & Vertical Geometry toolbox  

Start Store Point in Graphical COGO.  On the COGO toolbox, click on the upper left icon. 
Controls will then come up in the MicroStation tool settings dialog. 

Key in the initial point Id for your drainage easement points. All points should begin with a DR to 
indicate that they are Design R.O.W. points.  

Set Coordinates to Curvilinear for storing by station and offset.  

Click the down arrow to set the Chain Id name to the one the drainage easement break points 
need to be stored from. 
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Locate and store 1st proposed drainage easement point.  

As you move the cursor across the view window the point can be seen tracking along the 
alignment chain. If tracking does not occur check to make sure the correct chain name is set and 
click on the store point icon again.  

Snap to the beginning of the tentative drainage easement. 

Click the box next to Station and the one next to Offset to lock them. Adjust the station to be an 
even value. The offset is controlled by the prop. R.O.W. offset at that point and should not be 
changed.  After adjusting a value hit the Tab or Enter key to set the value. 

Once station and offset are set, data point anywhere in the view to store the point. In graphics the 
point symbol and number are visualized on level DESIGN - ROW - ROW and Easement GPK 
Visualizations (273).  
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Locate & Store remaining proposed drainage easement points.  

To store the next point, un-click the box next to Offset to return to tracking mode.  Since this 
drainage easement is at 90 degrees to the roadway, both stations on the left should be the same and 
only the offset varies. The same will be true on the right. Tentative snap to the next point, lock the 
offset and then adjust its value to be even.  Once offset is set, data point anywhere in the view to 
store the point. 

 
To store the next point, un-click the box next to Station to return to tracking mode.  Since the 
back of the drainage easement is parallel to the roadway, both offsets on the outside should be the 
same. Tentative snap to the next point, lock the station and then adjust its value to be even.  Once 
station is set, data point anywhere in the view to store the point. 

To store the last point, un-click the box next to Offset to return to tracking mode.  Tentative snap 
to the last point, lock the offset. The offset is controlled by the prop. R.O.W. offset at that point 
and should not be changed.  Data point anywhere in the view to store the point. 

 



 37

3. Store proposed drainage easement chain.  

Delete tentative drainage easement lines.  

Click on the store chain icon on the main COGO dialog or go to the drop down menu item 
Element > Chain > Store > From Elements. 

Enter the desired drainage easement chain name. It should begin with a D for Design chains and 
we recommend the use of ESMT so that it is easily recognized as a proposed easement chain.  

Station values do not matter so just use the setting, Begin at 0.00.   

Click once in the Elements List area. Double click on each of the visualized drainage easement 
points previously stored.  

Finally click on the Store Chain button to store the chain. 

 

The chain is automatically visualized on level DESIGN - ROW - ROW and Easement GPK 
Visualizations (273).  In the COGO dialog, we can see the chain has been stored. 
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4. Display & annotate proposed drainage easement.  

In MicroStation’s Level Display tool, set level DESIGN - ROW - Easement Linework and 
Patterning as the active level and use level filter Sheets - ROW Details to set the levels to be 
displayed for all files. If your plans do not include R.O.W. Details sheets then use level filter 
Sheets - Present Layout. 

Open Geopak’s Design & Computation Manager and access Prop. Easements. Select the type 
of easement line needed and then click on Draw Plan & Profile. 

 

 

In the Draw Plan & Profile dialog set element option to Chains and set the Label Scale to 50.   

The controls are pre-set to annotate distance and bearings but since our example drainage 
easement is small, those will probably overlap so click off Line Direction Labels & Line Length 
Labels. Click on the proposed drainage easement chain once to display the final stored lines.  
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The proposed drainage easement can be annotated quickly using T.D.O.T. Design Division 
labeling tools. 

Access the Label Station/Offset tool from Geopak’s D&C Manager at Drafting Standards > 
Prop. R.O.W. > StationOffset or with the T.D.O.T. Design Division interface from the 
MicroStation drop down menu at TDOT > R.O.W. > Label Station & Offset. 

Access Text Styles Plus… and click item, ROW Sta. & Offset – Prop. , to set text element 
parameters. 

In the Label Station/Offset dialog, set your Chain name and click the Dynamic button. The tool 
immediately starts tracking on the chain.  

Tentative snap to each corner of the drainage easement and data point. After the first data point, a 
second data point places the label.  Reset to end labeling. 
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Access the Place Bearing & Distance Label tool from Geopak’s D&C Manager at Drafting 
Standards > Prop. R.O.W. > BearingDistance or with the T.D.O.T. Design Division interface 
from the MicroStation drop down menu at TDOT > R.O.W. > Label Bearing & Distance. 

Access Text Styles Plus… and click item, ROW Bearing & Distance – Prop , to set text 
element parameters. 

In the Place Bearing & Distance Label dialog, click on the option to Place Label as Flag and then 
on the Identify Element button.  

Data point on each line of the drainage easement with another data point to accept it. After 
identifying the line, data point at the line for the end of the leader line and data point once more to 
position the label.  Reset to end labeling. 
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To label the drainage easement, access the Place Label with Leader Line tool from Geopak’s 
D&C Manager at Drafting Standards > Tools > LabelwithLeader or with the T.D.O.T. Design 
Division interface from the MicroStation drop down menu at TDOT > Tools > Place Label with 
Leader. 
Access Text Styles Plus… and click item, ROW & Easements – Prop. , to set text element 
parameters. 
In the Place Label with Leader Line dialog, click off the option for Horizontal Line and click on 
the Text - 2nd Line option. Key in PROP. PERMANENT for the 1st line of text and DRAINAGE 
ESMT. For the 2nd line. Click the Place Label button to start placement. Data point on or in the 
drainage easement area for the end of the leader line and data point once more to position the 
label.  

 

5. Pattern the proposed drainage easement area.  

Create a selection set of all the elements needed to close the area. All we need are the 4 elements 
which enclose the area so just start MicroStation’s Element Selection tool, hold the Ctrl key 
down and pick the 3 prop. drainage easement lines and the prop. R.O.W. line.  

Access the Pattern Drainage Easement Area function from Geopak’s D&C Manager at 
Drafting Standards > Prop. Easements > Drain Esmt Area. With the T.D.O.T. Design 
Division interface go to the MicroStation drop down menu at TDOT > Area Patterns > Design 
Area Patterns and choose Drainage Easement from the list. 
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MicroStation’s Pattern Area tool is started and all required settings are made. Click on the 
Flood option. 

 

Data point within the drainage easement area and data point again to accept the area 
indicated & place the pattern. Access the Element Selection tool again and data point in an 
empty area to drop the selection set. 

 



 43

Construction Easement for Slopes 

Slope easements and their associated construction easement areas are stored directly from graphics 
only.  

1. Open the proposed DGN file for your project.  

In MicroStation’s Level Display tool, set level DESIGN - ROW - Easement Linework and 
Patterning as the active level and use level filter Sheets - ROW Details to set the levels to be 
displayed for all files. If your plans do not include R.O.W. Details sheets then use level filter 
Sheets - Present Layout. 

2. In D&C Manager under Prop. Easements, click on the item Const. Esmt and click on Place 
Influence. 

 

 



 44

3.  Using MicroStation's Copy parallel by Distance command copy the slope lines parallel to form 
initial construction easement lines. Use the offset distance of 10' with conditions as specified on 
page 2-56 of the TDOT Design Division Roadway Design Guidelines. 

 

4. Using MicroStation's Extend 1 Line to Intersection & Extend 2 Lines to Intersection 
commands to clean up intersections of construction easement lines. 
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Patterning Slope Easement Areas 

1. Open the proposed DGN file for your project.  

In MicroStation’s Level Display tool, set level DESIGN - ROW - Easement Linework and 
Patterning as the active level.  Highlight all files in the Level Display tool, right click on your 
mouse in the level list and choose the option All Off. 

Turn on only those levels with elements needed to enclose the prop. Slope easement area to be 
patterned which includes the following levels: 
 SURVEY - PROPERTY - ROW Lines (15) 
SURVEY - PROPERTY - Property Lines (160) 
DESIGN - ROW - Slope Lines (43) 
DESIGN - ROW - Right-of-Way Linework (45).  

Note:  
Most easements have line work which will enclose the entire area but in the case of slope 
easements an extra line has to be added across the opening of private drives to close the area. Once 
finished level move these lines to a scratch level such as DESIGN - SCRATCH - User 1 (30) for 
later use in storing the easement area in the GPK file. 

2. Create any needed lines to handle driveway crossings. 

3. Create a selection set of all the elements needed to close the area.  

Data point & hold the mouse button down to drag a box across the elements to get most of them. 
Hold the Ctrl key down and data point any additional elements needed to enclose the area.  

Avoid large numbers of elements in the selection set which will cause problems with 
MicroStation closing the area. With this in mind do not include area patterns in your selection 
set since they often include large numbers of elements. 
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4. Access the Pattern Slope Easement Area function from Geopak’s D&C Manager at Drafting 
Standards > Prop. Easements > Slope Esmt Area. With the T.D.O.T. Design Division interface 
go to the MicroStation drop down menu at TDOT > Area Patterns > Design Area Patterns and 
choose Slope Easement from the list. 

MicroStation’s Pattern Area tool is started and all required settings are made. Click on the 
Flood option. 

 

5. Data point within the slope easement area and data point again to accept the area indicated & 
place the pattern. Access the Element Selection tool again and data point in an empty area to 
drop the selection set. 
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Storing Prop. R.O.W. & Easement Areas 

All areas should be stored as parcels in the project's GPK file. In order to maintain the integrity of the 
original parcels/tracts these areas will be stored as separate parcels.  

All proposed R.O.W. and easement areas will be named beginning with the parent tract's parcel 
number followed by a standard name indicating the type of area. The following naming conventions 
will be used to make these special parcels easily recognizable by T.D.O.T. R.O.W. personnel: 

Type         Feature  Format  Examples for parcel 5 

Area to be acquired       PROW  (parcel number)ACQ   5ACQ 

Drainage Easement       DEASMT  (parcel number)DRA         5DRA 

Slope Easement       SEASMT  (parcel number)SLP          5SLP 

Construction Easement   CEASMT  (parcel number)CON          5CON 

Multiple Areas of any Type 
In cases where multiple areas of a given type are required on a parcel then their names should be 
numbered in order as they occur along the roadway. For example if parcel 5 has 3 different slope 
easement areas their parcel names would be 5SLP1, 5SLP2 & 5SLP3.  
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Storing Proposed R.O.W. Area to be Acquired, Drainage Easements or special 
Construction Easements 

When storing drainage easements or special construction easements using these instructions, use SMD 
features DEASMT or CEASMT. 

1. Open the proposed DGN file for your project.  

In MicroStation’s Level Display tool, set level DESIGN - ROW - ROW and Easement GPK 
Visualizations as the active level.  Highlight all files in the Level Display tool, right click on your 
mouse in the level list and choose the option All Off. Turn on parcel level SURVEY - 
PROPERTY – Parcels (26).  No other graphics should be showing.  

2. Open your Geopak project & start COGO. 

3. Set the active COGO feature to PROW.  

In the COGO dialog click on the Browse button  

In the SMD browser window select PROW under Design > Property/ROW. 

 

 Change the visualization option in the COGO dialog to Temporary Visualization. 

4. Start Geopak's Store Graphics COGO command from the Horizontal & Vertical Geometry 
toolbox (4th icon from left) or from the MicroStation menu bar under Applications > Geopak 
Road > Geometry > Store Graphics 
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5. Fill in the Store Graphics dialog. 

Set object type for storing to Parcel. 

Key in the parcel name, in this example for an acquired area on parcel 5 we would enter 5ACQ.  

Key in a beginning point number. This will usually fill in automatically but if needed use COGO 
Navigator to determine the next available point number.  

Click on the Auto Point Increment option.  

Click off the Auto Parcel Increment option.  

Set the parcel type to Parent Tract. We are storing our acquired areas separately from the original 
parcel so we will not be using the Take Area option. 

Shape is the only element set option available for parcels so the dialog will default to this mode.  

Set the storing mode to Automatic. If there is no way to completely isolate the graphics for 
storing a parcel then Semi-Auto storing mode may be used but the user will have to accept/reject 
all enclosing elements. 

Set the Default Direction to CW (clockwise). All parcels will always be stored in a clockwise 
direction in order to conform to the "Tennessee Land Surveyors Laws and Regulations" 2000 
Edition. 

Set Radius value to 5.00. Use the default value for Tolerance. 
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6. Identify area to be stored.  

Click the ID Shape button. 

User is prompted to Select Data Point for Outer Shape 

Data point anywhere inside area.  
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7.  Identify beginning point for storing area  

User is prompted to Choose Starting Point. 

Move cursor around until the dynamic circle jumps to the point in the upper left corner for parcels 
on the left or lower left corner for parcels on the right. This should be the beginning of the 
proposed R.O.W. on the parcel.  

Note: 
 This function gives you a chance to visually check the area about to be stored. If the circle jumps 
to a location not bounding your area, turn off graphics or visualize COGO elements as needed to 
solve the problem and re-start the command. 

Data point to accept the location. 
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8.  Accept the direction for storing area  

Arrows appear around boundary of area showing direction for storing area. 

Data point to accept a clockwise direction, if for some reason the arrows point in a counter-
clockwise, Reset to change to clockwise.  

 

9. Store the parcel area. 

When a data point is given to accept the direction, then the Store button at the bottom of the Store 
Graphics dialog becomes un-dimmed.  

Click the Store button to store the area. 

The Input File Name dialog appears. Click OK to store input commands and run them to store 
parcel area. 
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10. Review stored parcel. 

The visualized COGO elements are read and used to store the parcel 5ACQ. Any additional 
COGO elements needed are automatically created. In this example a new curve was needed along 
the existing R.O.W. so curve 5ACQ-1 was automatically created to match the survey curve. 
Points previously stored in the proposed R.O.W. and the parcel were used to close the area. 

 

Notes:  

In some locations the parcel may fail to store. Often this is because a point the software thought it 
needed to close the parcel failed to be stored. Review the COGO commands generated prior to the 
STORE PARCEL command. In the cases observed so far these points were not needed. If this is 
the case edit the STORE PARCEL command line and remove the point which caused it to fail and 
then hit enter. The parcel should store correctly the second time. 

Sometimes the software simply does not travel the path required to enclose the area when in 
Automatic storing mode. It may be necessary to use Semi-Auto mode in order to be able to accept 
or reject each segment which encloses the area. Review the next section which describes the use 
of that method when storing slope easements. 
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Use COGO Navigator to describe the new parcel which will provide the area needed to enter into 
the R.O.W. Acquisition block. After storing all areas the user can come back and describe all of 
the acquired parcel areas and then save the output to a file for reference or printing. 
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Storing Slope Easement Areas & their associated Construction Easements 

Storing slope easements and their associated construction easements will be done similar to proposed 
R.O.W. areas except we will run the Store Graphics command in a Semi-Auto mode and we will be 
using a combination of COGO elements & MicroStation elements to enclose the areas. 

When storing construction easements for slopes using these instructions use SMD feature CEASMT. 

1. Open the proposed DGN file for your project.  

In MicroStation’s Level Display tool, set level DESIGN - ROW - ROW and Easement GPK 
Visualizations as the active level.  Highlight all files in the Level Display tool, right click on your 
mouse in the level list and choose the option All Off. Turn on levels SURVEY - PROPERTY – 
Parcels (26) and DESIGN - ROW - Slope Lines (43).  No other graphics should be showing.  
When storing the construction easements for slope construction you will need to turn on level 
DESIGN - ROW - Easement Linework and Patterning but it should be off while storing slope 
easements as shown here. 

2. Open your Geopak project & start COGO. 

3. Set the active COGO feature to SEASMT.  

In the COGO dialog click on the Browse button  

In the SMD browser window select SEASMT under Design > Property/ROW. 

 
Change the visualization option in the COGO dialog to Temporary Visualization. 

4. Start Geopak's Store Graphics COGO command from the Horizontal & Vertical Geometry 
toolbox (4th icon from left) or from the MicroStation menu bar under Applications > Geopak 
Road > Geometry > Store Graphics 
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5. Fill in the Store Graphics dialog. 

Set object type for storing to Parcel. 

Key in the parcel name, in this example for the first slope easement on parcel 2 we would enter 
2SLP1.  

Key in a beginning point number if not set automatically.  

Click on the Auto Point Increment option.  

Click off the Auto Parcel Increment option.  

Set the parcel type to Parent Tract. We are storing our easement separately from the original 
parcel so we will not be using the Easement option. 

Shape is the only element set option available for parcels so the dialog will default to this mode.  

Set the storing mode to Semi-Auto.  

Set the Default Direction to CW (clockwise).  

Set Radius value to 5.00. Use the default value for Tolerance. 
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6.  On MicroStation's menu bar under Settings > View Attributes turn on Fill in the view you are 
working in.  

7. Identify area to be stored.  

Click the ID Shape button. 

User is prompted to Identify Element. 

Data point on the beginning slope line. 
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8.  Identify path around area. 

The filled dot will jump forward to the next element vertex or intersection. 

Data point to accept each location that is part of your parcel boundary. 

When a fork is encountered as shown below, Reset to choose the correct path. In the example 
below the dot goes up the drainage easement line at first rather than down the line to the prop. 
R.O.W.  

 

Continue with data points and resets as needed to return to the beginning point. When closed the 
shape will flash indicating closure and the Choose starting Point prompt will appear.  
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9.  Identify beginning point for storing area  

User is prompted to Choose Starting Point 

Move cursor around until the dynamic circle jumps to the point in the upper left corner for parcels 
on the left or lower left corner for parcels on the right. This should be the beginning of the 
proposed slope line on the parcel.  

Data point to accept the location. 
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10.  Accept the direction for storing area  

Arrows appear around boundary of area showing direction for storing area. 

Data point to accept a clockwise direction, if for some reason the arrows point in a counter-
clockwise, Reset to change to clockwise.  

 

11. Store the parcel area. 

When a data point is given to accept the direction, then the Store button at the bottom of the Store 
Graphics dialog becomes un-dimmed.  

Click the Store button to store the area. 

The Input File Name dialog appears. Click OK to store input commands and run them to store 
parcel area. 
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12.  Review stored parcel. 

Visualized COGO elements from proposed R.O.W. and drainage easement lines are read and used 
to store the parcel 2SLP1. Any additional COGO elements needed are automatically created. In 
this example, points along the slope lines as well as an intersection point at the drainage easement 
were automatically created. These new points combined with previously created COGO points 
were used to close the area. 

 

Since COGO was set to Temporary Visualization, the new point numbers shown in graphics will 
go away when the view is updated. 
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Use COGO Navigator to describe the new parcel which will provide the area needed to enter into 
the R.O.W. Acquisition block. 
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Modifying Proposed R.O.W. & Areas 

Many times small changes are necessary which do not require a total revision of work previously 
done. The following 2 sections illustrate updating chains and parcels after modification to the prop. 
R.O.W. In this example point DR503 is to be removed and intersection point DR510 must be 
relocated. 

Update Proposed R.O.W.  

1. Open COGO Navigator and access the Proposed R.O.W. Chain.  

Since we are re-defining this chain, click on the Re-Define button on the COGO dialog. Change 
the visualization option in the COGO dialog to Permanent Visualization. In the COGO dialog 
click on the Browse button and in the SMD browser window select PROW under Design > 
Property/ROW. 

Open COGO Navigator and double click on the proposed R.O.W. chain to be changed.  

The Store Chain by Elements dialog will open with the current definition of the chain displayed. 

2. Edit elements in the chain & re-store.  

Remove any deleted proposed R.O.W. points or curves. In our example, we need to remove point 
DR503 which is not going to be used and we also need to remove property line intersection point 
DR510 since it must be re-calculated.  

Double click on any new visualized points or curves to add them to the element list.  

Make sure there is a space between all elements in list.  

Click on the Store Chain button to re-store the chain. 
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3. Add new intersection point to chain & re-store.  

Open COGO Navigator and double click on the proposed R.O.W. chain to be changed.  

Double click on new visualized point to add it to the element list.  Make sure there is a space 
between all elements in list.  

Click on the Store Chain button to re-store the chain. 

4. Delete unused objects from the GPK file.  

Since point DR503 is no longer used it should be deleted from the GPK file. 

Open COGO Navigator and switch to Points. Scroll through the points list and find the point to 
be removed.  

Click on the point and click the delete icon at the top of the dialog. When prompted to accept the 
deletion, click OK.  

. 

 

In graphics, the visualized point information is automatically removed.  
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5. Update proposed R.O.W. & annotation for plans. 

Delete all annotation or lines that no longer apply to the proposed R.O.W. For our example, we 
need to delete the station and offset flags at old point DR503 and previous location of point 
DR510, as well as the distance and bearing labels between points DR502 and DR504.  We also 
can delete one line since we removed one break in the R.O.W. 

Modify proposed R.O.W. lines as needed.  Use MicroStation’s Modify tool or other methods to 
correct the lines by snapping to altered COGO visualization graphics. 

Access the T.D.O.T. Design Division Label Station/Offset tool to place new labels as needed. 
Open Text Styles Plus… and click item, ROW Sta. & Offset – Prop. , to set text element 
parameters. 

In the Label Station/Offset dialog, set your Chain name and click the Dynamic button. The tool 
immediately starts tracking on the chain. Tentative snap to the new location of point DR510. After 
the first data point, a second data point places the label.  Reset to end labeling. 

Access the T.D.O.T. Design Division Bearing & Distance Label tool to place new labels as 
needed. Open Text Styles Plus… and click item, ROW Bearing & Distance – Prop, to set text 
element parameters. 

In the Place Bearing & Distance Label dialog, click on the option to Place Label as Flag if leader 
lines are needed. In our example, after removing the break point at DR503 we now have adequate 
room to place the labels on the line.  Once settings are made, click on the Identify Element button. 

Data point on each line to be labeled with another data point to accept it. After identifying the line, 
tentative snap with midpoint or project snap active to place the label on the line.  Reset to end 
labeling 

 
If needed, use the Place Single Proposed ROW Marker tool to update or replace markers at 
prop. R.O.W. break points. 
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Update Proposed R.O.W. Area to be Acquired. 

1. Open COGO Navigator and access the Proposed R.O.W. area to be acquired parcel.  

Since we are re-defining this parcel, click on the Re-Define button on the COGO dialog.  

Open COGO Navigator and double click on the proposed R.O.W. parcel stored for tract 5 
5ACQ.  

 

The Store Parcel by Elements dialog will open with the current definition of the parcel 
displayed. 
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2.  Edit elements in the parcel & re-store.  

Remove any deleted proposed R.O.W. points or curves. Note that if points are deleted from the 
GPK file they are automatically removed from the parcel.  

Double click on any new visualized points or curves to add them to the element list. Make sure 
there is a space between all elements in list.  

Click on the Edit Parcel From Elements button to re-store the parcel. Review in COGO to see 
changes in area. 
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Adjusting Distance Labels on Property Lines 

The R.O.W. Division requires that at any location where the proposed R.O.W. crosses a property line 
the distance label of that property line be revised to show the distance on both sides of that crossing. 

Although we need to adjust the distance label, the line work of the property line or parcel should 
never be broken or otherwise changed. 

1. Open the project’s survey DGN file.  

In MicroStation’s Level Display tool, set level SURVEY - PROPERTY - Property Lines Text 
as the active level and use level filter Sheets - ROW Details to set the levels to be displayed for 
all files. If your plans do not include R.O.W. Details sheets then use level filter Sheets - Present 
Layout. 

Also, turn on level DESIGN - ROW - ROW and Easement GPK Visualizations in the 
proposed DGN file reference.  

2. Start T.D.O.T. Design Division’s Place Bearing & Distance Label tool. 

In D&C manager activate BearingDistance. The Place Bearing & Distance Label dialog 
appears. 

 
With the T.D.O.T. Design Division interface active, this tool can also be accessed from the 
MicroStation drop down menu at TDOT > R.O.W. > Label Bearing & Distance 

3. We only need to label Distance, so click off the Bearing label option. 
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4. Before placing labels, we need to set the appropriate active element settings.  

Click on the Text Styles Plus… button. Scroll through the list and pick Property Line – Exist. 

 
5. Start label placement. In the Place Bearing & Distance Label dialog … 

Click on the Identify Element button. You are prompted to Identify Element for annotation, data 
point on the property line between the proposed R.O.W. line element and the present R.O.W. line. 
Reset until the proposed R.O.W. acquired parcel shape from the proposed file is identified. The 
label tool reads the line segment along the property line to set up the label. Data point to accept. 

You are then prompted to Position Label, data point to place the new distance label text.  
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If needed, use the option to Place Label as Flag. Reset the Terminator Type if desired. This 
option defaults to the small arrowhead which works best in crowded areas of annotation. 

After the label location point is given, a reset will stop label placement and restart the tool at the 
Identify Element prompt. At this point, you may wish to continue along the proposed R.O.W. 
line to label the distance on other property lines between the proposed & present R.O.W.  

6. Now, the original property line text label needs to be edited.  

First we need to calculate the length beyond the proposed R.O.W. In our example the original total 
length was 341.76’ and the new length between the proposed & present R.O.W. is 32.26’. We can 
subtract those to see that the new outside length needs to be 309.50’. 

Start MicroStation’s Edit Text tool and identify the original label. Edit the distance and data point 
in the file to apply the change. 

. 

After editing …. 
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Finalizing the GPK File for Project Submittal 

For R.O.W. project submittals … take the following steps to indicate final roadway centerline chains 
and profiles that are used in the project.  This applies to side roads as well as the main roadway on the 
project. 

For Construction project submittals … review the GPK file to ensure that the final roadway 
centerline chains and profiles that were specified at R.O.W. project submittal are still valid. If needed, 
take these steps to update the file to correctly reflect the final roadway centerline chains and profiles. 

This must be done to avoid confusion when the GPK coordinate geometry database file is 
passed on to other divisions for their use. Any alternates developed during the design process can 
then remain in the file for possible later use as needed. 

1. Open your Geopak project and start Coordinate Geometry. 

2. Open COGO Navigator and make settings for editing.  

In COGO Navigator go to the drop down option Tools > Settings. 

In the Settings dialog click on the option for Single Click Enables List Cell Editing.  

Click OK to accept change in settings. 
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3.  Edit Description for each final proposed roadway centerline chain & profile COGO object in the 
GPK coordinate geometry database file.  

Expand COGO Navigator so that the Description field is visible. 

Single click in the Description field.  

Key in description in the following format to indicate that it is the final definition which is used for 
the project.  Substitute the roadway name for name. 

Proposed name Final ROW 

 

4. In COGO Navigator go to the drop down option Tools > Settings, and in the Settings dialog click 
off the option for Single Click Enables List Cell Editing.   

This is needed to avoid accidental changes to objects listed in COGO Navigator. 
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